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If the equipment described herein bears the symbol, the said equipment complies with 
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If the equipment described herein bears an FCC statement, the said equipment complies with 
the relevant Federal Communications Commission standards.
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Certification Information
Certification Information

F.C.C. INFORMATION TO USER

This product has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 (Subpart B) of the FCC Rules. 
These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This unit generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance 
with the instruction manual, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this unit does cause harmful 
interference to radio or television reception, which can be determined by 
turning the unit off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

➤ Reorient or relocate the receiving antenna.

➤ Increase the separation between the unit and receiver.

➤ Connect the unit into an outlet on a circuit different from that to which 
the receiver is connected.

➤ Consult the dealer or an experienced radio/TV technician for help.

WARNING
Changes or modifications not expressly approved by EXFO 
Electro-Optical Engineering Inc. could void the user’s authority to 
operate the unit.
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Certification Information
➤ This unit is equipped with a shielded three-wire power cord and plug. 
Use this power cord in conjunction with a properly grounded electrical 
outlet to avoid electrical shock and to reduce radio frequency 
interference that may emanate from the power cord.

➤ Use of shielded remote I/O cables, with properly grounded shields and 
metal connectors, is recommended in order to reduce radio frequency 
interference that may emanate from these cables.

➤ When the GPIB option is present, this unit is equipped with a shielded 
GPIB cable.

INDEPENDENT LABORATORY TESTING

This product has undergone extensive  certification testing both 
internally, at EXFO, and externally, at an independent, qualified laboratory. 
All pre-qualification tests were performed at EXFO while all final tests were 
performed at UltraTech Engineering Labs Inc., a renowned test laboratory 
from Mississauga, Canada. This guarantees the unerring objectivity and 
authoritative compliance of all test results.

INFORMATION TO USER

This product has been tested and found to comply with the limits for a 
Class B digital device. Please see the Declaration of Conformity.
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1 IQ-200 Optical Test System 
Overview

The IQ-200 product line is a modular optical test system designed for 
laboratory application. Thanks to the Windows compatible IQ-200 
Software, the IQ-200 Optical Test System combines power, performance, 
and flexibility with a user-friendly interface. The main components of the 
system are the IQ-203 Control Unit, which can house up to three modules, 
and the IQ-206 Expansion Unit, which can house up to six modules. It is 
also possible to control IQ-206 Expansion Units with an IQ-206 Expansion 
Card inserted in a PC.

IQ-203 Control Unit
The IQ-203 is the mainframe of the IQ-200 Optical Test System. The IQ-203 
controls all the modules, whether they are inserted in the IQ-203 itself or in 
an IQ-206 Expansion Unit. The standard IQ-203 integrates a Pentium MMX 
microprocessor PC architecture. It can be equipped with a network 
interface card (Ethernet or other), allowing you to connect to a Local Area 
Network (LAN).

The Windows compatible IQ-200 Software simultaneously controls all 
modules via the IQ-203 bus. Upon delivery, this software is already installed 
on the IQ-203 Control Unit and ready to run. For more information about 
the IQ-200 Software, see Using the IQ-200 Optical Test System on page 35.

All software commands can be controlled with the hardware keys and 
mouse provided on the unit front panel. However, an external mouse and 
an optional keyboard allow easier operation. Also, the addition of a VGA 
monitor can enhance the visual aspect of the applications, just as a printer 
can be useful for producing hard copies.

The IQ-203 has room for three single-slot interchangeable modules and 
can control up to four IQ-206 Expansion Units: the total system capacity is 
27 single-slot modules. For more information about a typical IQ-200 setup, 
see Installing and Connecting the IQ-200 Hardware on page 13.

In addition to operating the IQ modules, any commercial software 
(spreadsheets, word processors, etc.) can also be installed on the IQ-203, 
although the warranty may be void in certain cases.
Optical Test System 1



IQ-200 Optical Test System Overview
IQ-203 Control Unit
IQ-203 Front Panel

HDD

F

IQ

IQ-203

HOLD

OPTICAL TEST SYSTEM
A B C

ACTIVE

OUT

IN

LIGHT SOURCE

IQ-2100IQ-1100 IQ-3100

POWER METER VARIABLE ATTENUATOR

Electro-Optical Engineering

3.5” high density 
floppy disk drive

Loads or saves data on 
floppy disk.

Front panel keys

Activate different software 
commands (see Using the 
Front Panel Keys on 
page 43).

Integrated 
VGA display

Front panel mouse

Activates software 
commands, like a 
conventional mouse.

IQ modules

ON/OFF button

Powers the IQ-203 
on and off.

Contrast buttons

Set the contrast of the 
integrated VGA screen.

Brightness buttons

Set the brightness of the 
integrated VGA screen.

Hard disk drive LED

Illuminates when the hard 
disk drive is in use.

Retractable legs

Facilitate the inclination of 
the IQ-203.
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IQ-200 Optical Test System Overview
IQ-203 Control Unit
IQ-203 Back Panel

Note: Actual ports on your unit may differ from those depicted in the illustration.

This symbol, found at the back of the IQ-203 Control Unit, 
indicates that you should refer to the instruction manual for fuse 
replacement and power rating. The fuse replacement 
procedure is given in Replacing the Fuses on page 60.

GPIB port (optional)

Fan

Certification and 
warning label

Monitor port

Modem card 
and ports 
(optional)

AC socket

Fan

Printer port

IQ-206 port

Additional DB9 serial port (optional)

DB9 serial port

Nameplate

Keyboard port

Fuse 
holder

Mouse port (PS/2)

Ver.

Mfg.
date

P/N

S/N

Made in Canada QST-94
465 Godin Ave.
Vanier, Que., Canada G1M 3G7

This device complies with part 15 of the FCC rules.  Operation is
subject to the following two conditions: (1) this device may not cause
harmful interference  and (2) this device must accept any interference
received, including interference that may cause undesired operation.

IQ 203 -I1

21325-1A

B-1.0

JANUARY 2001 Manufacturing 
date

Part number

Serial number

Product version
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IQ-200 Optical Test System Overview
IQ-206 Expansion Unit
IQ-206 Expansion Unit
The IQ-206 is called the expansion unit of the IQ-200 Optical Test System 
because it is usually used to expand the module capacity of an IQ-203 
Control Unit. You can link up to four IQ-206 Expansion Units to an IQ-200 
Optical Test System. Each IQ-206 Expansion Unit can support up to six 
modules, which are either controlled from an IQ-203 Control Unit or an 
IQ-206 Expansion Card, via the Windows compatible IQ-200 Software.

You can find installation instructions for the IQ-206 Expansion Unit in 
Installing and Connecting the IQ-200 Hardware on page 13, as well as help 
with the software in Using the IQ-200 Optical Test System on page 35.

IQ-206 Front Panel

D E FA B CIQ-206EXPANSION UNIT

ACTIVE

OUT

IN

LIGHT SOURCE

IQ-2100IQ-1100 IQ-3100

POWER METER VARIABLE ATTENUATOR

RM

IN

IQ-3300

VARIABLE REFLECTOR

OUT

OPTICAL SWITCH

IQ-9100

S2

C

S1

OPTICAL SWITCH

IQ-9100

C

S1

S2

S3

S4

Electro-Optical Engineering

Sequential position display

Indicates the position of the unit within the 
IQ-200 system. The unit closest to the IQ-203 
Control Unit or IQ-206 Expansion Card is 
numbered 1, the second closest is numbered 
2, etc., up to four IQ-206 Expansion Units.

IQ modulesON/OFF button

Powers the IQ-206 on and off.
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IQ-200 Optical Test System Overview
IQ-206 Expansion Unit
IQ-206 Back Panel

This symbol, found at the back of the IQ-206 Expansion Unit, 
indicates that the user should refer to the instruction manual for 
fuse replacement and power rating. The fuse replacement 
procedure is given in Replacing the Fuses on page 60.

IQ output port

Used to link the unit 
to another IQ-206 
Expansion Unit

IQ input port

Used to link the unit
to an IQ-203 Control 
Unit, IQ-206 Expansion 
Card, or IQ-206 
Expansion Unit

Fan

Nameplate

Fan Certification and 
warning label

Fuse 
holder

Ver.

Mfg.
date

P/N

S/N

Made in Canada QST-94
465 Godin Ave.
Vanier, Que., Canada G1M 3G7

This device complies with part 15 of the FCC rules.  Operation is
subject to the following two conditions: (1) this device may not cause
harmful interference  and (2) this device must accept any interference
received, including interference that may cause undesired operation.

IQ 206 -I1

21325-1A

B-1.0

JANUARY 2001 Manufacturing 
date

Part number

Serial number

Product version
Optical Test System 5



IQ-200 Optical Test System Overview
IQ-206 Expansion Card
IQ-206 Expansion Card
The IQ-206 Expansion Card is designed to emulate an IQ-203 Control Unit. 
Once installed in a PC, the IQ-206 Expansion Card allows you to control up 
to four IQ-206 Expansion Units, which represent 24 single-slot IQ modules.

To operate the IQ-206 Expansion Card, you need to install the Windows 
compatible IQ-200 Software on the host computer. The IQ-200 Software 
used with the IQ-206 Expansion Card is identical to the software on the 
IQ-203 Control Unit.

➤ For information about how to connect the IQ-206 Expansion Card to an 
IQ-206 Expansion Unit, see Installing the IQ-206 Expansion Card on 
page 19.

➤ For details about installing the software on a PC, see Installing the 
IQ-200 Software on page 27.

➤ For help with the use of the software, see Using the IQ-200 Optical Test 
System on page 35.

Your IQ-206 Expansion Card will look different depending if it is an ISA or 
PCI card and the installation method will be different. Use the following 
illustrations to determine whether your card is ISA or PCI.
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IQ-200 Optical Test System Overview
IQ-206 Expansion Card
PCI Expansion Card Diagram

ISA Expansion Card Diagram

DIP switches
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IQ-200 Optical Test System Overview
Remote Control of the IQ-200 Optical Test System
Remote Control of the IQ-200 Optical Test 
System

In addition to stand-alone operation, the IQ-200 Optical Test System can be 
remotely controlled through one of the following methods:

➤ GPIB interface

➤ RS-232 external interface

➤ Windows OLE (Object Linking and Embedding) automation

➤ Windows DDE (Dynamic Data Exchange) communication channel

The GPIB and IQ-Application Development Guide, included with each 
IQ-203 Control Unit and IQ-206 Expansion Card, explains the different 
integrated configuration options and describes in detail how to create 
high-level integrated applications.

CAUTION
Devices that will allow the IQ-200 Optical Test System to be controlled 
remotely must be installed at the factory. Attempting to install any 
other device will void the product warranty.
8 IQ-200



2 Safety Information
Safety Conventions

You should understand the following conventions before using the product 
described in this manual:

WARNING
Refers to a potential personal hazard. It requires a 
procedure which, if not correctly followed, may result 
in bodily harm or injury. Do not proceed beyond a 
WARNING unless you understand and meet the 
required conditions.

CAUTION
Refers to a potential product hazard. It requires a 
procedure which, if not correctly followed, may result 
in component damage. Do not proceed beyond a 
CAUTION unless you understand and meet the 
required conditions.

IMPORTANT
Refers to any information regarding the operation of 
the product which you should not overlook.

Safety Precautions
The following safety precautions must be observed while operating and 
servicing the units. Failure to comply with these precautions or with 
specific indications elsewhere in this manual violates safety standards of 
intended use of the unit. EXFO assumes no liability for the user's failure to 
comply with these requirements.

CAUTION
Use of controls, adjustments and procedures for operation and 
maintenance other than those specified herein may result in 
hazardous radiation exposure.
Optical Test System 9



Safety Information
Electrostatic Discharge Precautions
WARNING
The IQ-203 Control Unit was designed to be a test instrument that 
should not be opened by users. EXFO is not responsible for any 
personal injury incurred while attempting internal service of the 
IQ-203 Control Unit or IQ-206 Expansion Unit.

➤ Unit covers cannot be removed during operation.

➤ Before powering on the unit, all grounding terminals, extension cords, 
and devices connected to it should be connected to a protective 
ground via a ground socket. Any interruption of the protective ground 
will cause a potential shock hazard and possible personal injury.

➤ Whenever the ground protection is impaired, the unit must not be used 
and be secured against any accidental or unintended operation.

➤ Only fuses with the required rated current and specified type (normal 
blow, time delay, etc.) may be used for replacement. Do not use 
repaired fuses or short-circuited fuse holders.

➤ Any adjustments, maintenance, and repair of opened units under 
voltage should be carried out only by skilled personnel aware of the 
hazard involved. Do not replace any components while power cable is 
connected. EXFO is not responsible for any personal injury incurred 
while manipulating the unit.

➤ Operation of any electrical instrument around flammable gases or 
fumes constitutes a major safety hazard.

➤ Capacitors inside the unit may be charged even if the unit has been 
disconnected from its electrical supply.

Electrostatic Discharge Precautions
Electrostatic discharge (ESD) precautions must be taken at all times while 
handling the IQ-206 Expansion Card. Always work at an approved ESD 
work station or use an ESD ground strap when handling the IQ-206 
Expansion Card.
10 IQ-200



Safety Information
AC and Power Cable Requirements
AC and Power Cable Requirements
The IQ-203 can operate from any single-phase AC power source between 
100 V and 240 V (50/60 Hz). The maximum input current of the IQ-203 is 
1.5 A.

The IQ-206 can operate from any single-phase AC power source between 
100 V and 240 V (50/60 Hz). The maximum input current of the IQ-206 is 
3.0 A.

This unit uses an international safety standard three-wire power cable. This 
cable serves as a ground when connected to an appropriate AC power 
receptacle. The type of power cable supplied with each unit is determined 
according to the country of destination. The figure below illustrates the 
different power cables available.

Only qualified electricians should connect a new plug if needed. The color 
coding used in the electric cable depends on the cable. New plugs should 
meet the local safety requirements and include the following features:

➤ adequate load-carrying capacity

➤ ground connection

➤ cable clamp

Australia Great Britain

South Africa

Europe

United States
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Safety Information
AC and Power Cable Requirements
WARNING
To avoid electrical shock, do not operate the unit if there are signs of 
damage to any part of the outer surface (covers, panels, etc.). To 
avoid serious injury, the following precautions must be observed 
before powering ON the unit.

➤ If the unit is to be powered via an auto transformer for voltage 
reduction, connect the common terminal to the grounded power 
source pole.

➤ Insert the power cable plug into a power outlet with a protective 
ground contact. Do not use an extension cord without a protective 
conductor.

➤ Before powering ON the unit, connect the protective ground terminal 
of the unit to a protective conductor using the unit power cord.

➤ Do not tamper with the protective ground terminal.
12 IQ-200



3 Installing and Connecting the 
IQ-200 Hardware

The IQ-200 Optical Test System can include up to four IQ-206 Expansion 
Units connected in a daisy chain with an IQ-203, allowing 27 single-slot 
linked modules. Mounting all these units into a standard 19-inch 
equipment rack is an efficient setup, but units can easily and safely be 
stacked one on top of the other in benchtop format, as shown below:

Whether you select the benchtop or rack-mount setup for your system, you 
will always be able to take full advantage of the flexibility and expansion 
characteristics of the IQ-200 Optical Test System.

For additional flexibility and ease of use, you can add an external color VGA 
monitor, keyboard, and mouse to the IQ-203 Control Unit. The IQ modules 
are linked together by the IQ-203 interface bus.
Optical Test System 13



Installing and Connecting the IQ-200 Hardware
Setting Up the IQ-200 for Rack-Mount Use
Setting Up the IQ-200 for Rack-Mount Use
Each IQ-203 Control Unit and IQ-206 Expansion Unit has two rear cooling 
fans. Mount or position the units so that air can circulate freely around 
them. When operating the unit, choose a location that provides at least

➤ 75 mm (3 inches) of rear clearance

➤ 25 mm (1 inch) of side clearance (left and right)

➤ 25 mm (1 inch) of top clearance

Failure to provide adequate cooling clearance may result in an excessive 
internal temperature, thus reducing unit reliability.

Before being inserted into a rack, IQ-203 Control Units or IQ-206 Expansion 
Units must first be installed into an optional rack-mount kit. To do so,

1. Assemble the rack-mount panels and handles using the screws and 
lockwashers supplied with the kit.

Left panel

Right panel

Handle screws

Lockwashers

Handle screw

Lockwasher

Handles

Front panel
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Installing and Connecting the IQ-200 Hardware
Setting Up the IQ-200 for Rack-Mount Use
2. Power OFF the IQ-203/IQ-206 and remove the four bottom cover 
screws under the IQ-203/IQ-206 as shown below.

3. Slide the IQ-203/IQ-206 inward through the rack-mount front panel, 
with the front of the unit facing you. Be careful not to break the 
warranty stickers on the IQ-203/IQ-206.

Right flange

Right panel

Left flange

Left panel

Cover 
screws

Cover 
screws

IQ-203/206  Front panel

Rack-mount front panel

Flange
screws
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Installing and Connecting the IQ-200 Hardware
Setting Up the IQ-200 for Rack-Mount Use
4. Use the flange screws and flat washers supplied with the kit to secure 
the IQ-203/IQ-206 onto the rack-mount flanges.

5. Insert the rack-mounted IQ-203/IQ-206 into the cabinet as shown 
below and secure in place using the hardware supplied with the rack.
16 IQ-200



Installing and Connecting the IQ-200 Hardware
Connecting IQ-206 Expansion Units to an IQ-203 Control Unit
Connecting IQ-206 Expansion Units to an 
IQ-203 Control Unit

Up to four IQ-206 Expansion Units can be connected to the IQ-203 Control 
Unit, which represents a total of 27 single-slot modules. The necessary 
interface cable to connect an IQ-206 Expansion Unit to another IQ-206 
Expansion Unit or IQ-203 Control Unit is supplied with the IQ-206 
Expansion Unit. Connections are shown on the next page.

Note: As the IQ-206 Expansion Units are daisy chained, the sequential position 
is indicated by a number displayed on the unit front panel. The first unit 
connected to the IQ-203 is numbered 1.

IMPORTANT
For proper connection, firmly push the IQ interface cable into the 
appropriate port until it clicks twice. Improper connection may cause 
operation problems.

IQ interface cables are offered in 2.5-, 5-, and 8-feet lengths. For 
proper operation, the IQ interface cables used in a system should 
not be more than 12 feet.
Optical Test System 17



Installing and Connecting the IQ-200 Hardware
Connecting IQ-206 Expansion Units to an IQ-203 Control Unit
Note: Actual ports on your unit may differ from those depicted in the illustration.
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Installing and Connecting the IQ-200 Hardware
Installing the IQ-206 Expansion Card
Installing the IQ-206 Expansion Card
The IQ-206 Expansion Card is available in two models: ISA and PCI. Both 
cards provide the same functionality, but the installation procedure is not 
exactly the same, as explained below. To determine the type of card you 
have, see IQ-206 Expansion Card on page 6.

Minimum PC Requirements

The IQ-206 Expansion Card has a power consumption of less than 200 mA. 
The computer that will host the IQ-206 Expansion Card must have the 
following configuration:

➤ 486 DX4/75 with 16 MB of RAM (minimum)

➤ one free ISA expansion slot (AT 98-pin bus) or one free PCI slot

➤ Microsoft Windows 95/98 (other versions may not be supported)

➤ CD-ROM drive (local or via network)

Installing an ISA or PCI Card

To install the IQ-206 Expansion Card in a computer,

1. If you have an ISA card, set the DIP switches on the card as explained 
in Configuring DIP Switches on ISA Card on page 20.

Note: PCI cards are plug-and-play and require no DIP switch setting.

2. Power off the computer and unplug the AC cord.

3. Refer to the computer instruction manual to properly disassemble 
the computer cover and access the expansion slots.

IMPORTANT
Handle the IQ-206 Expansion Card as explained in Electrostatic 
Discharge Precautions on page 10.
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Installing and Connecting the IQ-200 Hardware
Installing the IQ-206 Expansion Card
4. Firmly insert the IQ-206 Expansion Card into any appropriate expansion 
slot with due care and secure the card in place.

5. Reassemble the computer cover and tightly replace every screw.

6. In the case of a PCI card, turn on the computer and ensure the card is 
correctly detected and its driver installed as explained in Adding a PCI 
Card in Microsoft Windows on page 23.

7. Install the IQ-200 Software (see Installing the IQ-200 Software on 
page 27).

Configuring DIP Switches on ISA Card

Hardware configuration is accomplished through DIP switches on ISA 
cards (see figures below). Use these DIP switches to set the I/O port 
address and IRQ number of the card so they do not conflict with any other 
card or component in your system.

Take note of your DIP switch settings. You will be asked to enter these 
settings at the end of the IQ-200 Software installation, so the IQ-200 
Software can locate the IQ-206 Expansion Card within the system.

IMPORTANT
When setting DIP switches, the ON position is 0 and the OFF position 
is 1.

IMPORTANT
The 6-switch bank must always be configured as shown.

O
N

1 2 3 4 5 6 7 8

1
0

1
0

I/O port address 
(switches 1 to 5)

IRQ number 
(switches 6 to 8)

O
N

1 2 3 4 5 6

I/O port address 
(switches 1 to 5)

These switches should always 
be configured as shown
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Installing and Connecting the IQ-200 Hardware
Installing the IQ-206 Expansion Card
The I/O port address is a hexadecimal number and must be any multiple of 
020h within the range of 060h to 03C0h. The hexadecimal address is then 
converted into binary code so the DIP switches can be set to the “1” 
position (OFF) or to the “0” position (ON). The most commonly used 
I/O addresses are listed in the following table.

Note: The recommended I/O port address is 300h. Other I/O ports may be set on 
the card. If you are unable to determine the DIP switch settings for the 
desired I/O port, contact EXFO.

I/O Port Address 
(hexadecimal)

DIP Switch Setting

5 4 3 2 1

0E0h 0 0 1 1 1

100h 0 1 0 0 0

120h 0 1 0 0 1

140h 0 1 0 1 0

160h 0 1 0 1 1

200h 1 0 0 0 0

2A0h 1 0 1 0 1

2C0h 1 0 1 1 0

300h 1 1 0 0 0

320h 1 1 0 0 1

340h 1 1 0 1 0
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Installing the IQ-206 Expansion Card
The possible IRQ numbers and their corresponding DIP switch settings are 
listed in the table below.

Note: The recommended IRQ number for the IQ-206 Expansion Card is IRQ9. 
If the host computer is equipped with a PS/2 mouse port, do not set the 
IQ-206 Expansion Card to IRQ12.

IRQ 
Number

DIP Switch Setting

6 7 8

IRQ5 0 0 0

IRQ7 1 0 0

IRQ9 0 1 0

IRQ10 1 1 0

IRQ11 0 0 1

IRQ12 1 0 1

IRQ15 0 1 1
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Adding a PCI Card in Microsoft Windows

Microsoft Windows will detect a new PCI card when you reboot your 
computer and automatically offer you to install new drivers. You will need 
access to a CD-ROM drive for this installation.

IMPORTANT
If your PC is not equipped with a CD-ROM drive, you could use the 
Direct Cable Connection or your network to access another PC. For 
help with these methods, see Accessing a Remote CD-ROM Drive with 
the IQ-203 on page 79.

Note: The illustrations provided in this section were made with Windows 98. The 
Wizard may look slightly different if you are using Windows 95, but the 
procedure is similar.

To make Microsoft Windows correctly detect the new PCI expansion card,

1. After inserting the PCI card into the computer, turn on the computer. 
When Windows is loaded, the Add New Hardware wizard will guide 
you through the steps of card detection.

2. Click on Next to start searching for drivers associated with the card.
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Installing the IQ-206 Expansion Card
3. Select the Search for the best driver option and click on Next.

4. Insert the CD-ROM that was included with your IQ-206 Expansion Card 
in your CD drive and check only the Specify a location box. Use the 
Browse... button to locate it and click on Next to start searching.

IMPORTANT
EXFO recommends that you do not use the Floppy disk drives or 
CD-ROM drive options. The Wizard may not recognize your drives 
using these options.

5. When the card driver is found, click on Next again to start installing it.
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Connecting IQ-206 Expansion Units to an 
IQ-206 Expansion Card

Once installed into a PC, the IQ-206 Expansion Card can control up to four 
IQ-206 Expansion Units, which represents a total of 24 single-slot modules. 
The necessary interface cable to connect an IQ-206 Expansion Unit to 
another IQ-206 Expansion Unit or IQ-203 Control Unit is supplied with the 
IQ-206 Expansion Unit. Connections are shown on the next page.

Note: As the IQ-206 Expansion Units are daisy chained, the sequential position 
is indicated by a number displayed on the unit front panel. The first unit 
connected to the IQ-206 Expansion Card is numbered 1.

IMPORTANT
For proper connection, firmly push the IQ interface cable into the 
appropriate port until it clicks twice. Improper connection may cause 
operation problems.

IQ interface cables are offered in 2.5-, 5-, and 8-feet lengths. For 
proper operation, the IQ interface cables used in a system should 
not be more than 12 feet.
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Note: Actual ports on your unit may differ from those depicted in the illustration.
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the IQ-200 Software
Installing the IQ-200 Software

If you have purchased an IQ-203 Control Unit, the IQ-200 Software should 
have been pre-installed at the factory. If you are to use the software with an 
IQ-206 Expansion Card or if you ever need to reinstall it on your IQ-203 
Control Unit, use the CD-ROM provided with your IQ-200 Optical Test 
System. In either case, Microsoft Windows must already be installed in the 
host unit.

IMPORTANT
If your PC is not equipped with a CD-ROM drive, you could use the 
Direct Cable Connection or your network to access another PC. For 
help with these methods, see Accessing a Remote CD-ROM Drive with 
the IQ-203 on page 79.

To install the IQ-200 Software on an IQ-203 or on a PC,

1. Insert the installation CD in your CD-ROM drive.

2. Select Run... from the Windows Start menu.

3. Type d:\setup (your drive letter may differ) in the Open text field.

4. Click on OK to launch the installation. The installation procedure first 
detects the type of platform (PC or IQ-203) on which you are installing 
the IQ-200 Software.

5. Close all programs, read the license agreement, and enter your name 
and company, clicking on Next > after each step.
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6. In the Select Components step, choose the software components you 
want to install on your IQ-203 or PC.

6a. Check the boxes corresponding to the components to install.

➤ Program Files: necessary files to use the IQ-200 Optical Test 
System software. This option is mandatory.

➤ EXFO Screen Saver: a Microsoft Windows screen saver that 
provides information about EXFO products and features.

➤ Manual and help files: instruction manuals of IQ modules 
and the IQ-200 Optical Test System, in PDF format.

➤ Acrobat Reader: the Adobe Acrobat Reader software for 
viewing the PDF instruction manuals.

IMPORTANT
Before installing Adobe Acrobat Reader, uninstall any previous version 
from your PC or IQ-203. If you uninstall the older version of Acrobat 
Reader after installing the new one, both versions will be uninstalled.

6b. Keep the default destination folder (C:\IQ) as is, unless you really 
need to change it.

6c. Click on Next > to move to the next step.
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7. In the Select GPIB Components step, choose the type of GPIB material 
you will use with your system.

7a. Select the radio button corresponding to your GPIB setup. 
Examples are given below:

➤ None: if you have no GPIB card in your system.

➤ GPIB Device Drivers: if you have a GPIB device card in your 
system. This card allows your system to be remotely 
controlled by another instrument.

➤ GPIB Controller Configuration: if you have a GPIB controller 
card in your system. Use this card to remotely control other 
instruments.

7b. Click on Next > to move to the next step.
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8. Verify the installation parameters and click on Next > to start installing 
files. During the installation, you will be asked to configure the IQ-200 
Software to match your hardware. For details, see Configuring the 
IQ-200 Drivers on page 31.

9. Read the information contained in the ReadMe.txt file. It provides 
last-minute information about the software and module applications. 
You can also find this file in the C:\IQ\Bin folder.

10. When the Adobe Acrobat Reader installation starts, you can choose to 
skip it. If you need to install Acrobat Reader later, the installation files 
are located on the IQ-200 Optical Test System installation media.

11. When the installation is completed, click on OK when you are asked to 
reboot your IQ-203 or computer.

12. If a Service Pack has been included with your shipment, you should 
install it now. Service Packs provide the latest software updates.

Note: For more information about using the IQ-200 Optical Test System and its 
software, see Using the IQ-200 Optical Test System on page 35.
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Configuring the IQ-200 Drivers
When running on a PC, the IQ-200 Software must match the configuration 
of the IQ-206 Expansion Card. The configuration utility allows you to set the 
IQ-200 Software drivers to the correct IRQ and base I/O address (ISA 
expansion card only) and to set the GPIB card parameters.

IMPORTANT
For the IQ-200 Optical Test System to function properly, it is important 
that no other device use the same IRQ and base I/O address.

The IQ-200 Software is configured through a small utility automatically 
accessed at the end of the IQ-200 Software installation. You can also access 
this utility at any time after the installation.

To configure the IQ-200 drivers with the IQ Configuration Tool,

1. Open the IQ Settings dialog box (shown below) by double-clicking on 
the IQ Settings icon at the bottom of the main window.

2. In the Hardware section, click on Config to display the IQ Configuration 
Tool, as shown below.
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Configuring the IQ-200 Drivers
The hardware equipment (IQ-203 Control Unit or IQ-206 Expansion 
Card) should be automatically detected.

IMPORTANT
When running on an IQ-203 Control Unit, the IQ-200 Software 
automatically configures itself to the default settings. In this case, 
you should not change the parameters in the IQ Configuration Tool.

3. If you are using an ISA expansion card, ensure that the parameters in 
the ISA Expansion Card Settings group box match the I/O address 
range and IRQ you have previously set on the card itself. The DIP switch 
illustration adapts to your choices.

4. If you plan to use a GPIB device card, check the Use GPIB Interface box 
and specify the I/O Adress Range and the IRQ to use.

5. Click on OK to accept the changes and exit the IQ Configuration Tool, 
or click on Cancel to exit without applying the changes.

6. Restart your system to make the changes effective.
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Uninstalling the IQ-200 Software
To uninstall the IQ-200 Software,

1. In the Windows Start menu, select Control Panel.

2. Select the Add/Remove Programs icon to display a list of all the 
software installed on your unit.

3. Select the one(s) you wish to remove and click on Remove. You may 
be asked to reboot your computer after the operation.
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5 Using the IQ-200 Optical Test 
System
Getting Started with the IQ-203 Control Unit

Before powering on the IQ-203 Control Unit and IQ-206 Expansion Unit, 
EXFO recommends that you carefully read the previous sections of this 
instruction manual to ensure that

➤ you comply with the safety precautions, power requirements, and 
other safety instructions given in Safety Information on page 9.

➤ you have connected the units together properly via the IQ interface 
cable as specified in Connecting IQ-206 Expansion Units to an IQ-203 
Control Unit on page 17.

WARNING
Any failure to respect the safety and operation guidelines given in this 
manual may void the product warranty and could result in product 
damage or personal injury.

To power on the IQ-200 Optical Test System,

1. Make sure that all units are properly connected.

2. Insert the desired modules into the IQ-203 Control Unit and IQ-206 
Expansion Units, as explained in Inserting Modules in the IQ-203 or 
IQ-206 on page 39.

CAUTION
Never insert a module while the IQ-203 Control Unit or IQ-206 
Expansion Unit is powered on. This will result in immediate and 
irreparable damage to the module and the IQ-203 or IQ-206.
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3. Power on the IQ-206 Expansion Unit(s) by pushing the ON/OFF button 
located in the bottom left corner of each unit.

IMPORTANT
Modules inserted in IQ-206 Expansion Units must be electrically 
powered for the IQ-200 Software to recognize them. Therefore, 
always power on the IQ-206 Expansion Units before powering on the 
IQ-203 Control Unit and loading the IQ-200 Software.

4. Power on the IQ-203 Control Unit by pushing the ON/OFF button 
located in the bottom left corner of the unit.

While booting up, the IQ-203 Control Unit performs the following 
operations in sequence:

➤ scans the hard disk for errors if the IQ-203 was not properly 
powered off. See Scanning Hard Disks for Errors on page 61.

➤ loads the Microsoft Windows operating system;

➤ loads the IQ-200 Software and opens the IQ-200 Optical Test 
System window;

➤ performs a self-test to demonstrate that communication has been 
established. During this test, the LED push buttons of all IQ 
modules light up in sequence.

For more information about the use of the IQ-200 Software, see 
Understanding the IQ-200 Software on page 41. If you encounter any 
problems, see Maintenance and Troubleshooting on page 59.
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Getting Started with the Expansion Card
Before powering on the PC with an IQ-206 Expansion Card and the 
IQ-206 Expansion Units, EXFO recommends that you carefully read the 
previous sections of this instruction manual to ensure that

➤ you comply with the safety precautions, power requirements, and 
other safety instructions given in Safety Information on page 9.

➤ you have connected the units together properly via the IQ interface 
cable as specified in Connecting IQ-206 Expansion Units to an IQ-206 
Expansion Card on page 25.

WARNING
Any failure to respect the safety and operation guidelines given in this 
manual may void the product warranty and could result in product 
damage or personal injury.

Note: For information about using the PC hosting the IQ-206 Expansion Card, 
refer to the instruction manual that came with the PC.

To power on the IQ-200 Optical Test SystemI,

1. Make sure that all units are properly connected.

2. Insert the desired modules into the IQ-206 Expansion Units, as 
explained in Inserting Modules in the IQ-203 or IQ-206 on page 39.

CAUTION
Never insert a module while an IQ-206 Expansion Unit is powered on. 
This will result in immediate and irreparable damage to the module 
and the IQ-206.
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3. Power on the IQ-206 Expansion Unit(s) by pushing the ON/OFF button 
located in the bottom left corner of each unit.

IMPORTANT
Modules inserted in IQ-206 Expansion Units must be electrically 
powered for the IQ-200 Software to recognize them. Therefore, 
always power on the IQ-206 Expansion Units before loading the 
IQ-200 Software.

4. Power on the computer hosting the IQ-206 Expansion Card and load 
Microsoft Windows (it is usually loaded automatically).

5. From the Windows Start menu, select Programs > EXFO > IQ Shell.

As the IQ-200 Software loads, it performs a self test to demonstrate that 
communication has been established with IQ modules. During this 
test, LED push buttons of all IQ modules light up in sequence.

For more information about the use of the IQ-200 Software, see 
Understanding the IQ-200 Software on page 41. If you encounter any 
problems, see Maintenance and Troubleshooting on page 59.
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Inserting Modules in the IQ-203 or IQ-206

CAUTION
Never insert a module while the IQ-203 Control Unit or IQ-206 
Expansion Card is powered on. This will result in immediate and 
irreparable damage to the module and the IQ-203 or IQ-206.

To insert an IQ module in the IQ-200 Optical Test System,

1. Exit the IQ-200 Software and power off the IQ-203 and IQ-206. If you are 
controlling modules from a PC, you do not need to turn the PC off.

2. Remove the protective cover of any unused module slot, by pulling the 
bottom of the cover and removing it completely.

3. Insert the IQ module into the empty slot. The IQ-203 or IQ-206 will 
automatically recognize which slot you selected.

 IMPORTANT
Be sure to insert the module all the way to the back of the IQ-203 or 
IQ-206 so that the backplane connectors are properly mated. The 
module is correctly inserted when its front panel is flush with the 
IQ-203 or IQ-206 front panel.

Bottom of 
protective cover
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Removing Modules from the IQ-203 or IQ-206

CAUTION
Never remove a module while the IQ-203 Control Unit or the IQ-206 
Expansion Unit is powered on. This will result in immediate and 
irreparable damage to the module and the IQ-203 or IQ-206.

Depending on the locking system with which the module is designed, 
there are two ways to remove an IQ module from the IQ-203 Control Unit 
or IQ-206 Expansion Unit.

1. Exit the IQ-200 Software and power off the IQ-203 and IQ-206. If you are 
controlling modules from a PC, you do not need to turn the PC off.

2. Place your fingers under the module front panel.

OR

Push up the locking mechanism under the module front panel, 
as shown below.

3. Firmly pull the module outward.

4. Put one of the supplied protective covers over the empty slot to prevent 
dust from entering the module housing.

2

1

Locking 
mechanism
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Understanding the IQ-200 Software
The IQ-200 Software main window is illustrated below.

The IQ module icons represent the modules detected by the IQ-200 Optical 
Test System at power up.

The module icon indicates the type of module and its position in the IQ-203 
Control Unit or IQ-206 Expansion Unit. The position is represented by

➤ a number, telling in which unit the module is inserted (0 for the IQ-203 
Control Unit and 1 to 4 for the IQ-206 Expansion Units).

➤ a letter, telling which slot the module occupies in the unit (A to C for 
the IQ-203 Control Unit and A to F for the IQ-206 Expansion Units).

Menu 
bar

Status 
bar

IQ Settings
icon

Module
application

icons

Minimized Application

Green icon
with no frame.

Closed Application

Red icon
with a frame.
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Using the Front Panel Mouse

The front panel mouse operates as a standard computer mouse.

To drag elements with the front panel mouse,

1. Using the arrow buttons, position the cursor on the selection.

2. Activate the mouse drag function by pressing the  button.

3. Drag the selection to the desired position using the arrow buttons.

4. Press on the left button to drop the selection and deactivate the 
mouse drag.

Left Button

To select elements.

Right Button

To display contextual menus.

Arrow Buttons

To move the mouse pointer.

Hold Button

To initiate mouse dragging.
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Using the Front Panel Keys

The IQ-203 front panel keys may be used as hardware keys, as described:

You may also use the keys to activate the software buttons aligned with 
them on the left side of an IQ application main window, as shown below:

Key Function

➤ When another Windows application runs, return to the IQ-200 Software.

➤ When an IQ application is open, display its monitor window.

➤ When several monitor windows are open, switch between them.

➤ When all IQ-200 front panel lights are turned off (see Activating and 
Deactivating the Front Panel Lights on page 46), return to the normal LCD 
and LED displays.

➤ Move between window items (as a tab).

➤ Scroll upwards in a list box.

➤ Select a check box option.

➤ Scroll downwards in a list box.

➤ Select an object or an option (as Enter or Return).

Use the  
key to activate 
or deactivate 
the software 
buttons.
Optical Test System 43



Using the IQ-200 Optical Test System
Understanding the IQ-200 Software
Typing Values with the Software Keypad

When an external keyboard is not available, you can use the numeric or 
alphanumeric software keypad to enter data in the IQ-200 Software.

To enter values using the software keypad,

1. Double-click in the box or field where a value must be entered to 
display the appropriate keypad window.

2. By clicking on the buttons, type the text or numbers you want. You may 
use the special keys shown in the above illustration while typing.

3. Save the value you typed or leave the keypad without saving the value. 
Keys are described in the above illustrations.

To erase a digit

To enter time values

To switch between positive
and negative values

To cancel data entry

To save the value and 
return to previous window

To erase a character

To save the text and 
close the keypad

To cancel data entry

To move to next line 
in a multiline field
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Customizing the IQ-200 Optical Test System

Selecting an LCD or CRT Screen

You can select to have the software displayed on the built-in screen of the 
IQ-203 Control Unit or on an external monitor.

To select the type of screen,

1. Open the IQ Settings dialog box (shown below) by double-clicking on 
the IQ Settings icon at the bottom of the main window.

2. Select the screen type in the Display section.

➤ LCD: built-in screen of the IQ-203 Control Unit.

➤ CRT: external monitor, if one is connected.

3. Click on OK to accept the changes.

Note: You can also select the desired screen type from the Display menu.
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Activating and Deactivating the Front Panel Lights

You can switch off all lights on all screens and module lights on the IQ 
components. This is useful when you need to use the IQ-200 Optical Test 
System in a dark environment.

Note: Floppy disk access light and hard disk LED may sometimes illuminate.

To activate or deactivate the front panel lights,

1. Open the IQ Settings dialog box (shown below) by double-clicking on 
the IQ Settings icon at the bottom of the main window.

2. Check the Turn Off All Lights box.

3. Click on OK to accept the changes.

Once screens and lights are deactivated, press the  front panel key to 
re-activate them.

Note: You can also activate or deactivate the front panel lights directly from the 
Display menu.
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Using the IQ-200 Optical Test System
Customizing the IQ-200 Optical Test System
Activating and Deactivating the Front Panel Keys

You can disable all front panel keys on your IQ-203 Control Unit to deny 
user intervention while your system is running.

To activate or deactivate the front panel keys,

1. Open the IQ Settings dialog box (shown below) by double-clicking on 
the IQ Settings icon at the bottom of the main window.

2. Check the Disable Front Panel Keys box.

3. Click on OK to accept the changes.

To activate the keys once they are deactivated, uncheck the box in the 
IQ Settings dialog box.

Note: You can also activate or deactivate the front panel keys directly from the 
Display menu.
Optical Test System 47



Using the IQ-200 Optical Test System
Customizing the IQ-200 Optical Test System
Changing Mouse Tracking Speed

You can set the delay for the first and second increase in tracking speed 
on your front panel mouse.

Note: This feature is enabled in non-Pentium systems only.

To change the front panel mouse speed,

1. Open the IQ Settings dialog box (shown below) by double-clicking 
on the IQ Settings icon at the bottom of the main window.

2. Move the scroll bars for Interval 1 or Interval 2.

3. Click on OK to accept the changes.

Selecting and Configuring a Printer

The printer selection procedure for the IQ-200 Optical Test System is the 
same as for any Windows-compatible software. Refer to the Microsoft 
Windows documentation for further details.
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Using the IQ-200 Optical Test System
Customizing the IQ-200 Optical Test System
Renaming Modules

You can customize the text appearing in the title bar of a module 
application. This may be useful when you use several similar modules.

To modify the module name,

1. Open the IQ Settings dialog box (shown below) by double-clicking on 
the IQ Settings icon at the bottom of the main window.

2. Click on the ID button in the Hardware section to display the Module 
Identification dialog box (shown below).

3. Select a module slot in the Module list. When you do so, the module’s 
current title appears on the right.

4. Change the current title using one of the following methods:

➤ Type a new name or change the current name in the title box.

➤ Click on Default to return to the factory-defined name.

5. Click on OK to accept the changes.
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Using the IQ-200 Optical Test System
Customizing the IQ-200 Optical Test System
Setting the Display Resolution for Module 
Applications

You can set all module applications to automatically launch in 
640 x 480 display resolution. Otherwise, applications will launch in the 
default resolution of your PC.

To ensure that all module applications start in 640 x 480 resolution,

1. Open the IQ Settings dialog box (shown below) by double-clicking on 
the IQ Settings icon at the bottom of the main window.

2. Check the Applications Always 640 x 480 box.

3. Click on OK to accept the changes.
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Using the IQ-200 Optical Test System
Customizing the IQ-200 Optical Test System
Opening and Saving a Software Configuration

Configuration files allow you to store commonly used parameters to reuse 
them later. Parameters that are saved include:

➤ position and size of monitor windows and module icons

➤ parameters defined in the IQ Settings dialog box

To open a previously saved configuration,

1. Select Open Config... from the File menu.

2. In the Open config dialog box, select a .CFG file.

3. Click on OK.

To save the current configuration at any time,

1. Select Save Config... from the File menu.

2. In the Save config dialog box, name your configuration (.CFG) file.

3. Click on OK.

To automatically save the current configuration when exiting the software,

1. Open the IQ Settings dialog box (shown below) by double-clicking on 
the IQ Settings icon at the bottom of the main window.

2. Check the Save Configuration on Exit box.

3. Click on OK to accept the changes.
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Using the IQ-200 Optical Test System
Starting and Using Module Applications
Starting and Using Module Applications
The main window of a module application contains all module operation 
commands. As an example, the main window of the IQ-1100 Power Meter 
application is shown below:

The IQ-200 Software is based on the Microsoft Windows operating system, 
so most module applications use standard Windows elements, such as:

Edit boxes

Data display and entry box 
that contains a value you 
may modify.

List boxes

Single value with a pull-down 
arrow. Contains many values, 
from which you select one.

Radio buttons

Provide a choice between two 
or more options, from which 
you may select only one.

Software buttons

to initiate an action or open 
a secondary dialog box.
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Using the IQ-200 Optical Test System
Starting and Using Module Applications
Note: For details about a particular module application, refer to the instruction 
manual of the IQ module. A list of available IQ modules is given in IQ 
Modules and Typical Applications on page 71.

Starting the Module Application

To open an IQ module application and display its main window,

➤ Double-click on the desired module icon along the bottom of the IQ 
Software main window.

OR

➤ Press the LED button on the module front panel.

Note: Module applications may be set to automatically launch in 640 x 480 
display resolution. For details, see Setting the Display Resolution for Module 
Applications on page 50.

Exiting the Module Application

To exit a module application,

➤ Click on  in the top right corner of the application main window.

OR

➤ Click on  in the top right corner of the module monitor window.

Module
icons
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Using the IQ-200 Optical Test System
Displaying the Module Monitor Window
Displaying the Module Monitor Window
The monitor window of a module is a small window containing basic 
operation information for quick reference. It is ideal for use in tile format 
on the screen (27 monitor windows can be viewed simultaneously).

The monitor window for the IQ-1100 Power Meter is shown below:

Note: Refer to the instruction manual that came with your particular module for 
further information about its monitor window.

Opening a Monitor Window

To open the monitor window of a module, use one of the following ways:

➤ In the main window of the module application, select Monitor from the 
Display menu.

➤ Minimize the module application main window by clicking on  in 
the upper right corner.

➤ While the main window of the module application is displayed, 
press the LED button on the module front panel.
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Using the IQ-200 Optical Test System
Displaying the Module Monitor Window
Arranging Monitor Windows on the Screen

To arrange all open monitor applications on the screen in a standard 
Windows cascade format, select Cascade from the Window menu.

To arrange all open monitor applications on the screen in a standard 
Windows tile format, select Tile from the Window menu.

Showing or Hiding the Function Button Keypad

You can right-click on the required monitor window to access the function 
button keypad as shown below. Clicking anywhere outside the function 
button keypad will hide the latter.

Closing the Monitor Window

To close the monitor window and return to the module main window, 
double-click anywhere in the monitor window.
Optical Test System 55



Using the IQ-200 Optical Test System
Controlling the IQ-200 Remotely
Controlling the IQ-200 Remotely
The status bar indicates the module control status as described in the 
following table. For more information about remotely controlling the IQ-200 
Optical Test System, refer to the GPIB and Application Development Guide.

To use the SCPI Manager utility, select SCPI Manager from the Run menu. 
For details about this utility, refer to the GPIB and Application Development 
Guide.

Exploring Drive Contents and Running 
External Software

To explore the contents of your local or network drives and run external 
software, use one of the following options from the Run menu:

Indication Meaning

Local The IQ-200 Optical Test System is controlled locally.

Remote The IQ-200 Optical Test System is controlled remotely but 
local commands can still be used.

Lockout The IQ-200 Optical Test System is controlled remotely only.

Option Function

Explorer Opens Windows Explorer.

Drive A: Gives access to drive A: through Windows Explorer.

Drive C: Gives access to drive C: through Windows Explorer.
56 IQ-200



Using the IQ-200 Optical Test System
Getting Help in the IQ-200 Software
Getting Help in the IQ-200 Software
The following table describes the possible ways to obtain help or 
information from the Help menu:

Option Function

Online Manual Opens this instruction manual in PDF format. You 
need to have Adobe Acrobat Reader installed on 
your IQ-200 Optical Test System.

Tip of the day Displays the Tip of the Day dialog box.

About... Displays a dialog box containing the following 
information:
➤ IQ-200 Software version

➤ contact information for technical support

➤ available IQ-203 system memory (RAM)

➤ remaining disk space on current drive
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Using the IQ-200 Optical Test System
Powering the IQ-200 Optical Test System Off
Powering the IQ-200 Optical Test System Off

IMPORTANT
Before powering off the IQ-203 Control Unit and IQ-206 Expansion 
Units, you must exit the IQ-200 Software and shut down Microsoft 
Windows.

To exit the IQ-200 Software and Microsoft Windows,

1. In the IQ-200 Optical Test System main window, select Exit from the 
File menu.

OR

Click on  in the top right corner of the main window.

An information window will appear indicating a subsequent 
deactivation of all module applications.

2. Choose OK to close all IQ module applications.

3. Shut down Microsoft Windows from the Windows Start menu.

To power off the IQ-203 Control Unit or IQ-206 Expansion Units, push the 
ON/OFF button located in the bottom left corner of each unit.
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6 Maintenance and 
Troubleshooting

The IQ-200 Optical Test System family components have been designed to 
require a minimum of maintenance and provide reliable operation for 
many years. In addition, the IQ-203 has the same characteristics as a 
computer, therefore, similar care should be taken.

Cleaning the IQ-203 Control Unit and IQ-206 
Expansion Unit

To help ensure long, trouble-free operation,

➤ keep the unit free of dust;

➤ be careful not to spill liquids into the unit. If the unit does get wet, 
turn the power off immediately, and let the unit dry completely before 
turning it on again; and

➤ clean the unit with a slightly damp (with water) cloth.

To prevent dirt and dust from entering the module housing, replace 
the protective cover plate when a slot is not in use.
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Maintenance and Troubleshooting
Replacing the Fuses
Replacing the Fuses
The IQ-203 Control Unit and IQ-206 Expansion Unit each contain two 250 V, 
3.15 A (0.197 x 0.787 inches / 5 x 20 mm) slow blow fuses. The fuse holder 
is located on the unit back panel, just beside the socket.

To replace the fuses,

1. Unplug the power cord from the unit.

2. Pull the fuse holder out.

3. Verify and replace the fuses if necessary.

4. Ensure that the fuses are firmly in the holder prior to reinsertion.

5. Firmly push the holder back into place.

Use only with a 250V fuse
Employer uniquement avec

un fusible de 250V
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Maintenance and Troubleshooting
Defragmenting Drives and Files
Defragmenting Drives and Files
Over time, as applications read, write, and delete files, information stored 
on the IQ-203 Control Unit hard disk may become fragmented. Basically, 
fragmented files are longer to access and read than unfragmented files. To 
reorganize the files on the disk and, thus, optimize disk performance, it is 
recommended to perform a defragmentation at least weekly.

To initiate a defragmentation, from Windows Explorer go to C:\WINDOWS 
and double-click on the file DEFRAG.EXE. For more information on 
ScanDisk, refer to the Microsoft Windows documentation.

Scanning Hard Disks for Errors
Microsoft ScanDisk is a program used to detect errors on a computer drive. 
Once found, the erroneous files are fixed and saved in the drive’s root 
directory, under the name «FILE0000.CHK», «FILE0001.CHK», 
«FILE0002.CHK», etc.

In the Windows environment, a ScanDisk is automatically performed at 
power up every time the IQ-200 Optical Test System has not been properly 
shut down. It is recommended to verify the «.CHK» files from time to time 
and delete the needless ones to free disk space.

Every time a ScanDisk is performed, the results of the disk analysis are 
stored in the SCANDISK.LOG file. The SCANDISK.LOG is used to identify 
any erroneous files detected at startup. It is recommended to occasionally 
delete this file to prevent it from wasting disk space. For more information 
on ScanDisk, refer to the Microsoft Windows documentation.
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Maintenance and Troubleshooting
Troubleshooting the IQ-203 Control Unit and IQ-206 Expansion Unit
Troubleshooting the IQ-203 Control Unit and 
IQ-206 Expansion Unit

Problem Probable Cause Recommended Action

IQ-203 or IQ-206 does 
not power ON.

AC power not applied. Verify AC power cord connection, 
then power on IQ-203 or IQ-206.

Fuse blown Verify the fuses (see Replacing the 
Fuses on page 60).

Blank LCD/CRT 
display on IQ-203

LCD/CRT display not 
activated

Press the  front panel key, or 
select an LCD/ CRT display in Display 
menu when LCD/CRT lights up.

External display not on Turn on external display.

Panel keys, mouse, 
and/or keyboard do 
not respond.

No communication 
between 
keys/mouse/keyboard 
and computer

Power OFF IQ-203 and IQ-206 
Expansion Units and secure IQ 
modules in place as well as verify 
mouse, keyboard, and all cable 
connections, then power on IQ-203.

LCD flickers Improper color scheme 
setting

Exit the IQ-200 Software and access 
the Windows Control Panel. 
Double-click on Display. In the 
Display Properties window, choose 
the Appearance tab. From the 
Scheme list, select High Contrast 
White.

IQ-206 Expansion 
Unit sequential 
position display 
indicates "E".

IQ-206 Expansion Unit 
not connected to IQ-203 
or to IQ-206 Expansion 
Card.

Power OFF IQ-203 and IQ-206; 
properly connect interface cable; 
then power on IQ-206, followed by 
IQ-203.
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Maintenance and Troubleshooting
Troubleshooting the IQ-206 Expansion Card
Troubleshooting the IQ-206 Expansion Card

Problem Probable Cause Recommended Action

IQ-200 Software 
does not detect 
IQ modules 
installed in an 
IQ-206 Expansion 
Unit.

➤ The IQ-206 Expansion 
Unit is not powered on.

➤ The modules are not 
properly inserted into 
their slot.

➤ The IQ interface cable 
is not properly 
connected.

➤ The card is not 
properly connected.

➤ The IQ-206 Expansion 
Card conflicts with 
another card installed 
in the computer.

1. Power off the PC running the IQ-200 
Software and power off the 
IQ-206 Expansion Unit.

2. Make sure the modules are properly 
inserted into their slots.

3. Make sure the IQ interface cable is 
properly connected.

4. Make sure the IQ-206 Expansion 
Card is properly installed.

5. Make sure other cards installed in 
the computer do not conflict with 
the IQ-206 Expansion Card.

6. Power on the IQ-206 Expansion Unit 
and load the IQ-200 Software.

PC hosting the 
IQ-206 Expansion 
Card does not 
boot.

IQ-206 Expansion Card is 
not properly installed.

Remove the card from the host 
computer, clean the edge connectors 
of the card, then reinstall the card as 
described in Installing the IQ-206 
Expansion Card on page 19.

Address conflict

Verify that I/O ports address and IRQ of 
other cards do not conflict with that of 
IQ-206 Expansion Card (see Configuring 
DIP Switches on ISA Card on page 20).

Mouse or 
keyboard not 
responding.

Address conflict

Verify that I/O ports address and IRQ do 
not conflict with that of IQ-206 
Expansion Card (see Configuring DIP 
Switches on ISA Card on page 20).
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Maintenance and Troubleshooting
Transportation and Storage
Transportation and Storage
Maintain a temperature range within specifications when transporting or 
storing the unit. Transportation damage can occur from improper handling. 
The following steps are recommended to minimize the possibility of 
damage:

➤ Pack the unit in the original packing material when shipping.

➤ Store unit at room temperature in a clean and dry area. Avoid high 
humidity or large temperature fluctuations.

➤ Keep the unit out of direct sunlight.

➤ Avoid unnecessary shock and vibration.

Contacting the Customer Service Group
If you encounter any difficulty while using this product, please call EXFO at 
one of the offices listed below. Our Customer Service Group is available in 
North America from 7:30 a.m. to 8:00 p.m. (Eastern Time), Monday to 
Friday.

EXFO Electro-Optical Engineering Inc.
(Corporate Headquarters)
465 Godin Avenue
Vanier (Quebec) G1M 3G7
CANADA

1 800 663-3936 (USA and Canada)
Tel.: (418) 683-0211
Fax: (418) 683-2170
support@exfo.com
www.exfo.com

EXFO Europe
Centre d’Affaires Les Metz
100, rue Albert Calmette
78353 Jouy-en-Josas
FRANCE

Tel.: +33.1.34.63.00.20
Fax: +33.1.34.65.90.93
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7 Technical Specifications
Electrical Specifications

Mechanical Specifications

IQ-203
Control Unit

IQ-206
Expansion Unit

IQ-206
Expansion Card

Supply voltage 100 to 240 VAC 100 to 240 VAC —

Line frequency 50 to 60 Hz 50 to 60 Hz —

Maximum input current 1.5 A 3.0 A —

Fuse 250 V, 3.15 A 
slow blow

250 V, 3.15 A 
slow blow

—

Installation overvoltage category II II —

Power — — 5 VDC <200 mA

IQ-203
Control Unit

IQ-206
Expansion Unit

IQ-206
Expansion Card

Number of slots 3 6 —

Dimensions

Width: 14.25”/36 cm Width: 14.25”/36 cm Thickness: 0.8”/2.0 cm

Height: 5.75”/14.5 cm Height: 5.75”/14.5 cm Height: 4.8”/12.2 cm

Length: 12”/30.5 cm Length: 12”/30.5 cm Length: 6.5”/16.4 cm

LCD (VGA) 
monitor

Width: 5”/12.5 cm — —

Height: 3.5”/9 cm — —

Weight 11.7 lb/5.3 kg 7.7 lb/3.5 kg —
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Environmental Specifications
Environmental Specifications

IQ-203
Control Unit

IQ-206
Expansion Unit

IQ-206
Expansion Card

Operating temperature 32° to 122°F
(0° to +50°C)

32° to 131°F
(0° to +55°C)

32° to 131°F
(0° to +55°C)

Storage temperature -4° to 140°F
(-20° to +60°C)

-40° to 158°F
(-40° to +70°C)

-4° to 140°F
(-20° to +60°C)

Relative humidity 80% 
(non-condensing)

95% 
(non-condensing)

95% 
(non-condensing)

Maximum altitude 6000 ft./2000 m 6000 ft./2000 m

Pollution degree 2 2
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8 Warranty
General Information

EXFO Electro-Optical Engineering Inc. (EXFO) warrants this equipment 
against defects in material and workmanship for a period of two years 
from the date of original shipment. EXFO also warrants that this equipment 
will meet applicable specifications under normal use.

During the warranty period, EXFO will, at its discretion, repair, replace, 
or issue credit for any defective product. This warranty also covers 
recalibration during a two-year period if the equipment is repaired or if 
the original calibration is erroneous.

IMPORTANT
The warranty can become null and void if

➤ the equipment has been tampered with, repaired, or worked upon by 
unauthorized individuals or non-EXFO personnel.

➤ the warranty sticker has been removed.

➤ case screws, other than those specified in this manual, have been 
removed.

➤ the case has been opened, other than as explained in this manual.

➤ the equipment serial number has been altered, erased, or removed.

➤ the equipment has been misused, neglected, or damaged by accident.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES EXPRESSED, 
IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. IN NO EVENT SHALL EXFO BE LIABLE FOR SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES.
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Warranty
Liability
Liability
EXFO shall not be liable for damages resulting from the use of the 
purchased product, nor shall be responsible for any failure in the 
performance of other items to which the purchased product is connected 
or the operation of any system of which the purchased product may be a 
part.

EXFO shall not be liable for damages resulting from improper usage or 
unauthorized modification of the product, its accompanying accessories 
and software.

Exclusions
EXFO reserves the right to make changes in the design or construction of 
any of its products at any time without incurring obligation to make any 
changes whatsoever on units purchased. Accessories, including but not 
limited to fuses, pilot lamps, and batteries used with EXFO products are not 
covered by this warranty.

Certification
EXFO certifies that this equipment met its published specifications at the 
time of shipment from the factory.

Service and Repairs
EXFO commits to providing product service and repair for five years after 
the date of purchase.

For service or repair of any equipment, follow the procedure below:

1. Call EXFO Customer Service Group. Support personnel will determine 
if the equipment requires service, repair, or calibration.

2. If the equipment must be returned to EXFO or an authorized service 
center, support personnel will issue a Return Merchandise 
Authorization (RMA) and an address for return.
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Warranty
Service and Repairs
IMPORTANT
Never send any unit or accessory back to EXFO without a Return 
Merchandise Authorization (RMA).

3. If the unit has an internal storage device, do a backup of your data 
before sending the unit for repairs.

4. Pack the equipment in its original shipping material. Be sure to include 
a statement or report fully detailing the defect and the conditions under 
which it was observed.

5. Return the equipment, prepaid, to the address given by the support 
personnel. Be sure to write the RMA on the shipping slip. EXFO will 
refuse and return any package that does not bear an RMA.

Note: A test setup fee will apply to any returned unit that, after test, is found to 
meet the applicable specifications.

After repair, the equipment will be returned with a repair report. If the 
equipment is not under warranty, the customer will be invoiced for the cost 
appearing on this report. Return-to-customer shipping costs will be paid by 
EXFO for equipment under warranty. Shipping insurance is at the 
customer’s expense.
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A IQ Modules and Typical 
Applications
List of IQ Modules

The following table lists the IQ modules available when this instruction 
manual was printed. To obtain the most recent information or for further 
details, please contact EXFO.

 Module 
Number

 Module
Descriptive Name

 Module 
Number

 Module
Descriptive Name

IQ-1100 Power Meter (single channel) IQ-5100B Polarization Controller

IQ-1200 4-Channel Power Meter IQ-5240 Optical Spectrum Analyzer

IQ-1500 Calibration Power Meter IQ-5310 Wavelength Meter

IQ-1600 High-Speed Power Meter Series
(1, 2, or 4 channels)

IQ-5320 Multi-Wavelength Meter

IQ-2100 Light Source IQ-5500 PMD Analyzer

IQ-2300 ASE Broadband Source IQ-6100 Erbium Doped Fiber Amplifier

IQ-2400 WDM Laser Source IQ-7200 Multimode OTDR Series

IQ-2600 Tunable Laser Source IQ-7300B Singlemode OTDR Series

IQ-2600B Tunable Laser Source IQ-7400B Singlemode OTDR Series

IQ-3100 Variable Attenuator IQ-7500B Singlemode OTDR Series

IQ-3200 Return Loss Meter IQ-9100 Fiber-Optic Switch

IQ-3300 Variable Reflector IQ-9600 Utility Module

IQ-3400B PDL/OL Analyzer IQ-9700 Passive Depolarizer
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IQ Modules and Typical Applications
Typical Applications for IQ Modules
Typical Applications for IQ Modules
The following table gives some typical test applications and the necessary 
IQ modules.

Passive Component
Testing

IQ
-1

60
0

IQ
-1

50
0

IQ
-1

20
0

IQ
-1

10
0

IQ
-2

10
0

IQ
-3

20
0

IQ
-3

30
0

IQ
-5

50
0

IQ
-3

40
0B

IQ
-5

10
0B

IQ
-9

70
0

P
M

D
 E

m
u

l.

IQ
-7

00
0

IQ
-9

10
0

Insertion loss X X X X X X X X X

Optical return loss X X X X X

Polarization dependant loss X X X X

Isolation and crosstalk X X X X

Polarization mode dispersion X X X

DWDM Passive Component
Testing

IQ
-1

6
0

0

IQ
-1

1
0

0

IQ
-2

60
0B

IQ
-2

6
0

0

IQ
-2

3
0

0

IQ
-3

2
0

0

IQ
-5

2
4

0

IQ
-5

3
2

0

IQ
-3

40
0B

IQ
-5

10
0B

IQ
-9

7
0

0

IQ
-9

1
0

0

Insertion loss vs. wavelength X X X X X X X X X

Optical return loss vs. wavelength X X X X X X

Polarization dependant loss
vs. wavelength X X X X X

Isolation and crosstalk vs. wavelength X X X X X X
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IQ Modules and Typical Applications
Typical Applications for IQ Modules
System
Testing

IQ
-1

6
0
0

IQ
-1

2
0
0

IQ
-1

1
0
0

IQ
-2

4
0
0

IQ
-2

3
0
0

IQ
-2

1
0
0

IQ
-3

1
0
0

IQ
-3

3
0
0

IQ
-5

2
4
0

IQ
-5

3
2
0

IQ
-6

1
0
0

IQ
-9

1
0
0

IQ
-9

6
0
0

Noise simulation X X

Tx-Rx X X X X X X X

Bit error rate (BER) X X X X X X X X X

Active 
Component

Testing IQ
-1

60
0

IQ
-1

50
0

IQ
-1

20
0

IQ
-1

10
0

IQ
-2

6
0
0
B

IQ
-2

60
0

IQ
-2

40
0

IQ
-3

10
0

IQ
-3

20
0

IQ
-3

30
0

IQ
-5

24
0

IQ
-5

32
0

IQ
-5

31
0

IQ
-5

1
0
0
B

IQ
-9

70
0

IQ
-6

10
0

IQ
-9

10
0

IQ
-9

60
0

EDFA X X X X X X X X X X X X

Photodetector X X X X X X X

Laser diode X X X X X X X X X X

Other
Applications

IQ
-1

5
0

0

IQ
-2

1
0

0

IQ
-3

1
0

0

IQ
-5

3
1

0

IQ
-5

5
0

0

P
M

D
 E

m
u

l.

IQ
-7

0
0

0

IQ
-9

1
0

0

IQ
-9

6
0

0
Calibration X X X X X

Fiber characterization X X X X X
Optical Test System 73



This page is intentionally left blank.



B Using the IQ-9600 Utility 
Module

The IQ-9600 Utility Module provides a secure, standardized way of 
integrating components such as couplers, isolators, filters, and Bragg 
gratings into the IQ-200 Optical Test System. Without such a module, these 
passive optical elements would end up loose on your workbench. This can 
cause damage or affect their adjustment.

The IQ-9600 Utility Module consists of an empty IQ module casing that fit 
into your IQ-203 Control Unit or IQ-206 Expansion Unit to house 
non-electrical elements (no electrical connections are provided).

The IQ-9600 Utility Module comes in either single-slot size (IQ-9601) or 
double-slot size (IQ-9602). The amount of material supplied with the utility 
module depends on the configuration, but it usually includes

➤ adhesive tape

➤ tie wraps

➤ splice holder

➤ connectors

Use the exploded views presented in this section as a reference 
for disassembling and reassembling the utility modules.
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Using the IQ-9600 Utility Module
Exploded View of Single-Slot Utility Module
Exploded View of Single-Slot Utility Module
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Using the IQ-9600 Utility Module
Exploded View of Double-Slot Utility Module
Exploded View of Double-Slot Utility Module
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C Accessing a Remote CD-ROM 
Drive with the IQ-203

To access an external CD-ROM drive with your IQ-203 Control Unit, you 
may use either a PC accessed through a network or one connected directly 
to your IQ-203. Using the network is easier if you have access to it from 
your IQ-203, but both methods are explained in this section.

Note: You may also use a portable CD-ROM drive connected to your IQ-203. 
In this case, refer to the drive documentation for help or instructions.

Sharing the CD-ROM Drive from the PC
The first thing you must do to access files and applications on the CD-ROM 
from your IQ-203 is to share the CD-ROM drive on the PC, no matter which 
method you use to connect the PC to your IQ-203.

To share the CD-ROM drive,

1. In Windows Explorer, select the CD-ROM drive letter (usually D:, but it 
may differ on your PC).

2. Right-click on the drive icon ( ) and select Sharing... to open the 
drive properties dialog box.

3. Select the Share as option and give full access to all users. The 
CD-ROM drive icon ( ) should now contain a hand.

Note: For more information about file sharing, refer to the Microsoft Windows 
documentation.
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Accessing the Remote CD-ROM from the 
IQ-203 Through a Network

IMPORTANT
Some computers are protected from remote access by the network 
security system, even if you shared drives or folders. If you are unable 
to access a computer via the network, you should contact your 
network administrator to verify your access rights.

To access the CD-ROM drive through a network,

1. Share the CD-ROM drive on the PC as explained in Sharing the CD-ROM 
Drive from the PC on page 79.

2. Identify the network name of the PC where the CD-ROM drive you 
want to use is located. You must do this from the PC itself.

2a. Select Start > Settings > Control Panel to start the Control Panel.

2b. Double-click on Network and select the Identification tab.

2c. Note the computer name for later use (circled in the illustration).
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Accessing the Remote CD-ROM from a PC Connected Directly to the IQ-203
3. Before accessing the files, make sure that both the PC and the IQ-203 
are turned on (so that the PC is “visible” to the IQ-203).

4. Open the Network Neighborhood by double-clicking on the desktop 
icon or selecting it in Windows Explorer. The complete list of 
computers logged on the network should appear gradually.

5. In the list, find the network name of the computer with the CD-ROM 
drive and double click on it. You will then have access to all the shared 
drives on this computer. You can use files or programs on the CD-ROM 
exactly as if it were a local drive.

Accessing the Remote CD-ROM from a PC 
Connected Directly to the IQ-203

Using the Windows’ Direct Cable Connection utility, you can connect the 
PC and the IQ-203 together using a parallel or serial cable. For this method 
to work, you need to set-up both systems with the same communication 
protocols.

Note: The direct method transfers data slower than a network connection.

Connecting the PC to the IQ-203

To connect a PC to your IQ-203,

1. Use a standard LapLink Parallel Cable or a LapLink Serial Cable 
(EXFO’s GP-216). Both are illustrated below:

Serial connector Parallel connector
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2. Connect the parallel or serial cable between the IQ-203 and the PC, as 
shown in the following illustration:

Configuring a Direct Cable Connection Protocol

The Microsoft IPX/SPX-compatible protocol for Windows allows to transfer 
files from the host computer (the PC with the CD-ROM drive) to the guest 
computer (your IQ-203).

IMPORTANT
The Microsoft IPX/SPX-compatible protocol must be installed on both 
systems for the connection to work.

To configure the network protocols,

1. Select Start > Settings > Control Panel to start the Control Panel.

2. Double-click on Network and select the Configuration tab.

IQ-203 PC
82 IQ-200



Accessing a Remote CD-ROM Drive with the IQ-203
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3. Check if the IPX/SPX-compatible protocol is available in the upper list. 
If not, add it as follows:

3a. Click on Add..., then double-click on Protocol.

3b. In the Select Network Protocol dialog box, select Microsoft in the 
Manufacturer list, then IPX/SPX-compatible protocol.

3c. Click on OK to add the new protocol.

4. In the Network Properties dialog box, ensure that the Primary Network 
Logon list box is set to Windows Logon. This setting determines who 
validates your user name and password, processes login scripts, and 
performs other tasks at start-up.
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Accessing the Remote CD-ROM from the IQ-203

Before accessing the CD-ROM from your IQ-203, you need to configure 
each system either as a host or a guest. Typically, the host is the PC with the 
CD-ROM drive and the guest is your IQ-203. You must also specify the 
communication ports that match the physical connection.

To access the CD-ROM from your IQ-203,

1. Configure the host so that it becomes available to the guest.

1a. Select Start > Programs > Accessories > Direct Cable Connection. 
If this option is not available, refer to the Windows documentation 
for installation instructions.

1b. If it is not already done, set the to Host computer set up to listen by 
clicking on Change... and going through the proposed steps. 
When you are done, the host is ready to accept a connection.
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2. Configure the guest using the same method as for the host. This time, 
you must set the Direct Cable Connection utility to Guest computer set 
up to connect to host. When you are done, the guest will try to establish 
the connection with the host as shown below.

3. If everything is set up properly, the guest should ask you for the name 
of the host computer. For details about how to find the host name, see 
Accessing the Remote CD-ROM from the IQ-203 Through a Network on 
page 80.

You will then have access to all the shared drives on this computer. You can 
use files or programs on the CD-ROM exactly as if it was a local drive.

Troubleshooting Direct Cable Connection
The following table provides solutions to common connection problems 
when using the Direct Cable Connection:

If you are still experiencing connection problems, do not hesitate to 
contact EXFO.

Problem Solution

The connection fails 
using the LPTx port.

➤ Try changing the port to a COMx port on 
both systems.

The connection does not 
work using any of the 
ports.

➤ Swap the host and guest systems.

➤ Check the cable pinout.

The connection seems to 
be established, but I 
cannot access my files.

Ensure that the CD-ROM drive is shared on the 
host computer and that the files are not 
protected from remote access.
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